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Microsoft Excel 2019 - Introduction 

 
Class Objectives 

• Excel Ribbon and Ribbon Tabs 

• Moving and Selecting Cells 

• Formatting Cells 

• Adding Worksheets, Rows and Columns 

• Resizing Rows and Columns 

• Freezing Panes 

• Formulas 

• Functions 

• Sorting 

• Charts 

• Autofill 

• Styles 

Microsoft Excel 2019 

Excel allows you to create spreadsheets much like paper ledgers that can perform automatic 
calculations. Each Excel file is a workbook that can hold many worksheets. The worksheet is a grid of 
columns (designated by letters) and rows (designated by numbers). The letters and numbers of the 
columns and rows (called labels) are displayed in gray buttons across the top and left side of the 
worksheet. The intersection of a column and a row is called a cell. Each cell on the spreadsheet has a cell 
address that is the column letter and the row number. Cells can contain text, numbers, or mathematical 
formulas.  

Microsoft Excel 2019 Screen Elements 

Excel Ribbon 
The Ribbon is the row of tool icons and shortcuts across the top portion of the screen.  The Ribbon is 
arranged into groups of related tools, and you can select different Ribbon Tabs to see different groups of 
tools and commands.  Here’s a quick overview of Excel’s Ribbon tabs: 

• File:  You can Save, Save As, Open, Close, Print and create a New workbook using this Tab.  The 
File Tab does not look like the rest of the Ribbons you’ll see when you click on the row of menu 
options.  Instead, in the File Tab, you see the above options (and more) listed on the left-hand 
side of the screen.  Microsoft sometimes refers to what you see when you click on the File Tab 
as the “Backstage View”.  Again, this is a companion feature to the Ribbon and doesn’t look like 
the other Ribbons. 

• Home: You’ll probably spend most of your time with the Home Tab selected.  This tab contains 
the basic Clipboard commands, Formatting commands, Style commands, commands to insert 
and delete rows or columns, plus an assortment of worksheet Editing commands. 

• Insert:  Select this tab when you need to insert something in a worksheet – a table, a diagram, a 
chart, symbol, and so on. 

• Page Layout:  This tab contains commands that affect the overall appearance of your worksheet, 
including settings that deal with Printing. 

• Formulas:  Use this tab to insert a Formula, name a range, access the formula auditing tools, or 
control how Excel performs calculations. 

• Data:  Excel’s data-related commands are on this tab, including Sort and Filter. 

• Review:  This tab contains tools to Check Spelling, Translate Words, Add Comments, or Protect 
Sheets so that they can’t be changed by other users. 
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• View:  The View tab contains commands that control various aspects of how a sheet is viewed.   

 

 

 

 

 

 

 

  

 

 

 

Moving and Selecting Cells 

You can use your mouse to click on any cell on your worksheet.  This will select the cell.  From there you 
can either format the cell or add data to the cell.  You can also use your mouse to select and highlight a 
range of cells by clicking on a cell and dragging the mouse over the rest of the cells you’d like to select.  
When you finish selecting your cells you can let go of the mouse button.  For keyboard strokes which let 
you move through and select cells, see one the tables below. 
 

Cursor Movement 

One cell up Up arrow  

One cell down Down arrow or Enter 

One cell right Right arrow or Tab 

One cell left Left arrow or SHIFT+Tab 

Top of worksheet (cell 
A1) 

CTRL+Home 

Where the last column 
with data intersects with 
the last row with data 

CTRL+End 

Any cell 
Enter the cell address in 
the Cell Number Box 

 Selecting Cells 

One cell Click once in the cell 

All cells left of 
current cell 

SHIFT+left arrow 

All cells right of 
current cell 

SHIFT+right arrow 

Entire column Click the column label 

Entire row Click the row label 

Entire worksheet 
Click the whole sheet 
button or CTRL+A 

Cluster of cells 
Drag mouse over the cells 
or hold down the SHIFT key 
while using the arrow keys 

Row 
Numbers 

Name box 

Menu tabs 

Title bar Quick access toolbar 

Ribbon 

Column letters 
Formula bar 

Close application Maximize/Restore 

Minimize application 

Scrollbar 

Zoom control 

Ribbon 

Sheet tabs 
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Move to next worksheet CTRL+PageDown 

Move to previous 
worksheet 

CTRL+PageUp 
 

Non-adjacent cells 
Hold down the CTRL key 
and use the mouse to click 
on non-adjacent cells 

 

 

Moving and Copying Cells  

Action Using the Home Ribbon Using the right mouse button Using the keyboard 

To cut the cell’s 
content that will be 
moved to another cell, 
highlight the cell and … 

Click on the Cut icon on the 
Home Ribbon. 

Right click on the highlighted 
cell, select Cut from the 
menu that appears. 

Use the keystroke 
CTRL + X 

To copy the cell’s 
content, highlight the 
cell and … 

Click on the Copy icon on 
the Home Ribbon.  

Right click on the 
highlighted cell, select Copy 
from the menu that 
appears.  

Use the keystroke 
CTRL + C 

Highlight the cell into 
which you want to 
paste the cut or copied 
cell and … 

Click on the Paste icon on 
the Home Ribbon. 

Select Paste from the menu 
that appears. 

Use the keystroke 
CTRL + V 

Drag and Drop 

Drag the highlighted border 
of the selected cell to the 
destination cell with the 
mouse. 

  

 

Formatting Worksheets 

Adding Worksheets, Rows, and Columns 
Highlight the cell, row or column where you’d like to make the insert.  While 
using the Home Ribbon, click on the drop-down arrow to the right of the word 
Insert.  A drop-down menu will appear with the option to Insert Cells, Insert 
Sheet Rows, Insert Sheet Columns or Insert Sheet. 

Formatting Cells 
While using the Home Ribbon, click on one cell or highlight multiple cells to 
be formatted.  You can use the icons and shortcuts on the Home Ribbon to 
change the Font (e.g. color of the font, fill of the background, 
underline/outline of the selected cells), Alignment or the way the data 
inside the cells is displayed.   
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Also, by clicking on the button with the $ will format all selected cells which 
contain numbers to be displayed with a dollar sign and two decimal places.  
Likewise, by clicking in the drop-down menu inside this section of the 
Ribbon, you have access to more choices – like formatting dates and more 
number formatting option.     

Resizing Rows and Columns 
There are several ways to resize rows and columns: 

1. Resize a row by dragging the line below the label of the row you 
would like to resize. Resize a column in a similar manner by dragging 
the line to the right of the label corresponding to the column you 
want to resize.  - OR –  

2. Click the Home Ribbon and select Format.  A drop-down menu will 
appear which will allow you to change the row height or the column width. - OR –  

3. Click the Home Ribbon and select Format.  A drop-down menu will appear which will allow you 
to select AutoFit Row Height or AutoFit Column Width.   This will make the column or row as 
wide or as deep as it currently needs to be. –OR – 

4. Select the column or row and then double-click on the line separating its label from the next 
label. This will make the column or row as wide or as deep as it currently needs to be. 

Freezing Panes 
If you have a large worksheet with column and row headings, these headings will not be visible when 
you scroll down or to the right.  Excel provides a handy solution to this problem:  freezing panes.  
Freezing panes keeps the headings visible while you’re scrolling through the worksheet. 

To freeze panes, start by moving the cell pointer to the cell below the row 
that you want to remain visible as you scroll vertically, and to the right of 
the column you want to remain visible as you scroll horizontally.  Then, 
chose the View Ribbon and click on the Freeze Panes button.  From here 
you can select whether to Freeze Top Row or Freeze First Column or Freeze 
Panes (i.e. freeze the row above and the column to the left) Excel inserts 
dark lines to indicate that frozen rows and columns.  The frozen row and 
column remain visible as you scroll throughout the worksheet.  To remove the frozen panes, click on the 
Freeze Panes button again and select the Unfreeze Panes option from the drop-down list. 

Formulas 

The distinguishing feature of a spreadsheet program such as Excel is that it allows you to create 
mathematical formulas and execute functions. Otherwise, it is not much more than a large table for 
displaying text.  

Formulas are entered in the worksheet cell and must begin with an equal sign "=". The formula then 
includes the addresses of the cells whose values will be manipulated with appropriate operands placed 
in between. After the formula is typed into the cell, the calculation executes immediately and the 
formula itself is visible in the formula bar. See the example below to view the formula for calculating the 
sub total for a number of textbooks. The formula multiplies the quantity and price of each textbook and 
adds the subtotal for each book. 
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To view the actual formula or function in the cell and its components, double-click on the cell or click 
once and press F2.  Also, if you select the cell, you will see the formula or function for the cell in the 
Formula Bar.    

Functions 

Instead of manually typing a formula into the formula bar, you can use the Formulas Ribbon to insert 
common functions such as Sum, Date, Average, Count, Max, etc. 

 

Activate the cell where the function will be placed and select Insert Function from the Formula Ribbon.  
From the Insert Function dialog box, you can enter a description of what you want to do or you can 
select a category.  Browse through the functions by clicking in the Select a Function menu choices. As 
each function name is highlighted a description and example of use is provided below the box.  Click OK 
to select a function.  

The next window allows you to choose the cells that will be included in the function.  Excel will suggest a 
range that it thinks might be relevant to where your cursor is; notice that there is a colon in between the 
range of cells.  If you would like Excel to use a different range, you can place your cursor in the field and 
edit the default range.  (Remember to include the colon.) 

Click OK when all the cells for the function have been selected.  

  

Formula Bar 
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Autosum  
The Autosum button right next to the Function Insert button contains a short list of 
functions you can access when you click on the triangle underneath the words Autosum.  
This works the same way the Insert Function button works in that you activate the cell in 
which you would like to insert the sum of contents from the column above or the row to 
the left of the activated cell.   

After clicking the Autosum button, Excel with suggest a range of cells that it thinks might be relevant to 
where your cursor is.  As with the Insert Function, you can edit the range. 

Autofill 
The Autofill feature allows you to quickly fill cells with repetitive or sequential data such as 
chronological dates or numbers, and repeated text. 

1. Type the beginning number or date of an incrementing series or the text that will be repeated 
into a cell.  

2. Select the handle at the bottom, right corner of the cell with the left mouse button and drag it 
down as many cells as you want to fill.  

3. Release the mouse button.  
 

If you want to Autofill a column with cells displaying the same number or date you must enter identical 
data to two adjacent cells in a column. Highlight the two cells and drag the handle of the selection with 
the mouse. 

Autofilling Functions 
Autofill can also be used to copy functions.  In the example below, column A and column B each contain 
lists of numbers and column C contains the sums of columns A and B for each row. The function in cell 
C2 would be "=SUM(A2:B2)". This function can then be copied to the remaining cells of column C by 
activating cell C2 and dragging the handle down to fill in the remaining cells. The Autofill feature will 
automatically update the row numbers as shown below if the cells are reference relatively. 
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Creating Charts 

Charts allow you to present data entered into the worksheet in a visual format using a variety of graph 
types. Before you can make a chart you must first enter data into a worksheet.  Once you have entered 
data, you can select the data and headings in the worksheet that you want represented in the new 
chart.  Click on the Insert Ribbon tab and then select the type of chart to create by clicking the button 
for the general type of chart (Column, Line, Pie, Bar and so on).  You can then select the thumbnail of 
the subtype you want to use from the button’s drop-down gallery. 

 

 

After you’ve created your chart, a Chart Tools tab will be available on the Ribbon.  You can refine the 
new chart as needed using the command buttons on the Design, Layout, and Format tabs under the 
Chart Tools contextual tab on the Ribbon. 

 

Copying a Chart to Microsoft Word 
A finished chart can be copied into a Microsoft Word document.  You can either copy the chart as a 
picture or copy it so that any changes made to the table in Excel will automatically update and change 
the chart you’ve imported into Word.   

To copy the chart as a picture, click on the chart (taking care to 
highlight the entire chart picture and not just an element of it).  
Using the Home Ribbon, click on the drop-down arrow on the right-
hand side of the Copy button.  Select Copy as Picture.  Now that the 
picture of the chart is on your clipboard, you can paste it into a 
Word document. 

To copy the chart so that any changes made to the table in Excel 
will automatically update the chart in Word, copy the chart from Excel.  Open Word and position your 
cursor where you’d like the chart to be.  Click on the arrow next to the Paste button on the Home 
Ribbon.  You will have several Paste options.  To link the Excel chart to the Word document choose 
either:  Use Destination Theme & Link Data -OR- Keep Source Formatting and Link Data.  Either option 
links the Excel table with the Word document.   
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Sorting 

Basic Sorts  
The Data Ribbon can be used to sort cells in a spreadsheet.  To sort by one column, highlight the cells 
that will be sorted and click the Sort Ascending (A-Z) button or Sort Descending (Z-A) button.  Note that 
if you do not include the adjacent cells, you will get a warning asking you if you wish to expand the 
selection.  

 

 

 
Complex Sorts 

To sort by multiple columns, follow these steps: 

1. Highlight the cells, rows, or columns that will be sorted.  
2. Select Sort button from the Data Ribbon.  
3. From the Sort dialog box, select the first column for sorting from the Sort By drop-down menu 

and choose either ascending or descending.  
4. Select the second column and, if necessary, the third sort column from the Then By drop-down 

menus. 

If the cells you highlighted included the text headings in the first row, mark My list has...Header row and 
the first row will remain at the top of the worksheet.  

Cell Styles 

The use of styles in Excel allows you to quickly format your worksheet, 
provide consistency, and create a professional look. Excel provides several 
preset styles which include predefined Headings, Colors, Fonts, Font Sizes 
and Border Styles to enhance the aesthetics of a spreadsheet.  To apply a 
predefined Style, highlight the cells to which the predefined style should be 
applied.  Select the Cell Styles drop-down box from the Home Ribbon. If you 
have a large screen, it may be displaying various cell styles right in the 
ribbon. You can click on any of the options to apply a preformatted style to your selected cells. 

Additional Resources 

Universal Class has an Excel 2019 and an Advanced Excel 2019 course. Find it on our website under 
Explore -> eLearning -> Universal Class. 

Books on Excel are located at the start of our nonfiction section at Dewey 005.54. 

You may also be interested in our Google Sheets classes. Google Sheets is a spreadsheet program like 
Excel, but free and available in the cloud, so great for collaboration. 


